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W-2 por Internet 
 
 
 

Contiene las siguientes lecciones: 
 
 

• Lección 1: Cómo Crear/Reanudar Formularios W-2 por 

Internet 

• Lección 2: Cómo Descargar Informes ya Presentados 

• Apéndice: Otras Páginas 
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LECCIÓN 1: CÓMO CREAR/REANUDAR FORMULARIOS «W-2 
ONLINE» 
Siga las siguientes instrucciones para crear hasta cincuenta informes con cincuenta formularios 
«W-2 Online» en cada registro.  

PASO 1: Dirija su navegador a la página del «Business Services Online (BSO, siglas en inglés) 
    titulada «Welcome to Business Services Online» (Bienvenido a los Servicios por    
    Internet para Empresas): www.segurosocial.gov/bso/bsowelcome.htm (sólo disponible  
    en inglés). 

 

http://www.segurosocial.gov/bso/bsowelcome.htm
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PASO 2: Seleccione el botón que dice «Log In» (Ingrese) en la página titulada «Business 
Services Online Welcome». El sistema mostrará la página titulada «Log In to Online 
Services» (Ingrese a los Servicios Electrónicos).  

 
 

PASO 3: Ingrese su «User ID» (Identificación de Usuario) y su «Password» (Contraseña). 

PASO 4:  Seleccione el encasillado que dice, He leído y estoy de acuerdo con estas condiciones     
    en la página titulada «Log In to Online Services». 

               Seleccione el botón que dice «Log In» para ver la página titulada «BSO Main Menu». 

               Para regresar a la página inicial del BSO titulada «Welcome to Business Services 
Online», seleccione el enlace que dice BSO Welcome que está en la parte de arriba o de 
abajo de la página. 
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PASO 5: Seleccione el enlace que dice «Report Wages to Social Security» (Ingrese los 

Registros de Salarios al Seguro Social) en la página del «BSO Main Menu». El sistema 
mostrará la página titulada «Wage Reporting Attestation» (Confirmación de la 
Presentación del Registro de Salario). 
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PASO 6: Seleccione el botón que dice «I Accept» (Acepto) en la página titulada «Wage 
Reporting Attestation» para ir a la página inicial del EWR. 

 Para regresar a la página del «BSO Main Menu», seleccione el botón que dice «I DO 
NOT Accept» (No Acepto). 

  

PASO 7: En la página inicial del EWR: 

 El indicador de los formularios «Forms W-2/W-3 Online» (Formularios W-2/W-3 
Electrónicos) es la pantalla predeterminada. 

Seleccione el enlace que dice, «Create/Resume Forms W-2/W-3 Online» 
(Crear/Reanudar Formularios W-2/W-3 en Formato Electrónico).  Si no se encuentran 
informes que no hayan sido presentados, el sistema mostrará la página que dice «Before 
You Create Your Form(s) W-2/W-3» (Antes de Comenzar a Llenar su(s) Formulario(s) 
W-2c/W-3). Si hay formularios W-2/W-3 que todavía presentados no han sido, el 
sistema mostrará la página titulada «Forms W-2/W-3 Online “Unsubmitted Reports”».   
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  Usted puede tener un máximo de cincuenta registros de salarios que no haya presentado. 
Cuando haya alcanzado el límite de cincuenta registros «guardados», se le requerirá que 
primero presente por lo menos uno de los registros guardados antes de que se le permita 
comenzar un registro nuevo. Si tiene cuarenta y nueve registros, o menos, puede 
continuar sin presentar los registros que ya existen). 

 

 

PASO 8: Seleccione el botón que dice «Start a New Report» (Comience un informe nuevo) en 
la página titulada «Unsubmitted Reports». El sistema mostrará la página titulada 
«Before You Create Your Form(s) W-2/W-3» (Antes que Comience a Llenar su(s) 
Formulario(s) W-2c/W-3).  

 Seleccione el enlace que dice Delete para borrar un informe que no ha sido presentado. 
Aparecerá la página que dice, “Are you sure you want to delete the unsubmitted report? 
(¿Está seguro que quiere borrar el informe que no ha sido presentado?).  

 Seleccione el botón que dice Cancel (Cancelar) para regresar a la página principal del 
EWR. 
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PASO 9: En la página titulada «Before You Create Your Form(s) W-2/W-3» (Antes que Comience a 
Llenar su(s) Formulario(s) W-2c/W-3): 

 Seleccione el año tributable, elija el nombre de una compañía y el tipo de formulario W-2 que 
está creando. Si ha recibido una Carta de reconciliación, seleccione el encasillado que dice 
«check».   

 Si ninguna de las situaciones nombradas en la sección que dice «Check for Exception» 
(Verifique si existe alguna excepción) aplica, seleccione el botón que dice Continue para ir 
a la página titulada «Employer Information for this Wage Report» (Información 
Empresarial para este Registro de Salarios).  

 Si alguna de las situaciones descritas en la sección de «Check for Exception» es aplicable, 
seleccione el encasillado y el botón que dice Continue para ir a la página titulada «W-2 
Online Restrictions» (Restricciones al Programa de W-2 Electrónico).  

 Seleccione el botón que dice Cancel, para regresar a la página inicial del EWR. 
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PASO 10: En la página titulada «Employer Information for this Wage Report»: 

Ingrese o revise la información de la empresa, información de la persona de contacto, 
cualquier otra información y seleccione el tipo de pagador y el tipo de empleador, luego 
seleccione el botón que dice «Continue» para ir a la página titulada «Enter W-2 
Information» (Ingrese la Información para el formulario W-2).  

Seleccione el botón que dice Cancel para regresar a la página inicial del EWR. 
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PASO 11: Ingrese la información necesaria para el W-2 en los encasillados correspondientes en   
la página titulada «Enter W-2 Information» (Ingresar la Información del Formulario  
W-2). Seleccione el botón que dice «Save and Start Next W-2» para guardar la 
información del formulario W-2 presente y comenzar otro. Es posible que el sistema 
muestre algunos sobre avisos. Si el sistema muestra un sobre aviso, puede proceder ya 
sea haciendo las correcciones al formulario W-2 o seleccionando el encasillado que 
invalida el sobre aviso. 

 Cuando termine creando los formularios W-2, seleccione el botón que dice «Save and 
Go to W-2 List» (Guardar e Ir a la Lista de los W-2) para continuar a la página 
titulada «W-2 List for this Submission» (Lista de los Formularios W-2 para esta 
Presentación). 

  Puede ingresar hasta un máximo de cincuenta formularios W-2. El número de los W-2 
actuales se muestra en la parte superior de la página titulada «Enter W-2 Information». 
Cuando haya ingresado el quincuagésimo formulario, el sistema ya no mostrará el botón 
que dice «Save and Start Next W-2» (Guardar y Comenzar otro W-2). 

 Seleccione el botón que dice «Cancel Changes» (Cancelar los Cambios) para rechazar los 
cambios efectuados a este W-2 e ir a la página titulada «W-2 List for this Submission».  

                  Seleccione el botón que dice «Delete this W-2» (Borrar este W-2): Si el formulario ha 
sido guardado previamente, el sistema mostrará la página que titulada «Are you sure you 
want to delete this W-2?» (¿Está seguro que quiere borrar este W-2?). Si el formulario no 
ha sido guardado previamente, el sistema mostrará la página titulada «W-2 List for 
Submission». 
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PASO 12: Las siguientes opciones están disponibles en la página titulada «W-2 List for this 
Submission» (Lista de los Formularios W-2 para esta Presentación):  

      Seleccione un nombre para ver y corregir la información del W-2.  

 Seleccione el enlace que dice Delete para borrar el W-2. Cuando seleccione este 
enlace, la página titulada «Are you sure you want to delete this W-2?» aparecerá para 
asistirlo. 

                 Seleccione el botón que dice Save and Quit para salir del formulario W-2 electrónico 
sin presentar su registro de salario al Seguro Social. Cuando seleccione este botón, la 
página titulada «Are you sure you want to save and exit W-2 Online without 
submitting your annual wage report to SSA?» aparecerá para ayudarlo. 

 Seleccione el botón que dice «Edit Employer Information» (Editar la Información 
Empresarial) para cambiar la información empresarial que ingresó anteriormente. 

      Seleccione el botón que dice Start a New W-2 para comenzar otro W-2.  
 

     Seleccione el botón que dice Continue to W-3 Preview para ver la página titulada 
«W-3 Preview for this Submission» (Exhibición Previa del W-3 para esta 
Presentación). 
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PASO 13: Las sumas que aparecen en los encasillados 16, 17, 18 y 19 en la página titulada «W-   
      3 Preview for this Submission» (Exhibición Previa del W-3 para esta Presentación) son     
       las sumas directas de las cantidades de los impuestos estatales que ingresó en los formularios        
      W-2. Si su intención es usar este formulario para informar a su estado y su estado tiene  
      diferentes reglas para reportar estas cifras, puede ingresar sus propias sumas y seleccionar el  
      encasillado que dice I Agree (Estoy de acuerdo) para continuar. El Seguro Social no  
      utilizará esta información ni tampoco la compartirá con ningún estado o entidad local.      
                 

Seleccione el botón que dice Continue para ir a la página titulada «Print Unsubmitted                        
Form(s) W-2/W-3 for Review» (Imprima los Formularios W-2/W-3 que no se han   
Presentado). 
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 Seleccione el botón que dice Return to W-2 List para regresar a la página titulada 
«W-2 List for Submission». 

                Seleccione el botón que dice Save and Quit para salir del W-2 electrónico sin 
presentar el registro de su salario al Seguro Social. Cuando seleccione este botón, la 
página «Are you sure you want to save and exit W-2 Online without submitting your 
annual wage report to SSA? » aparecerá para ayudarlo. 

 

 
PASO 14: En la página titulada «Print Unsubmitted Form(s) W-2/ W-3 for Review» puede                             

elegir una de las siguientes opciones: 

Seleccione el botón que dice «Continue» para continuar a la página titulada «Sign                                            
and Submit».   

Seleccione el botón que dice «Return to W-2 List» (Regresar a la Lista de 
formularios W-2) para regresar a la página titulada «W-2 List for this Submission». 

Seleccione el botón que dice «Save and Quit» para salir del W-2 electrónico sin 
presentar la información al Seguro Social. Cuando seleccione este botón, la página 
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titulada «Are you sure you want to save and exit W-2 Online without submitting your 
annual wage report to SSA?» aparecerá para ayudarlo. 

 

PASO 15: Seleccione el encasillado en la página titulada «Sign and Submit» para verificar la 
exactitud del informe y seleccione el botón que dice «Submit This Wage Report 
Correction» para presentar la corrección del registro de su salario. El sistema 
mostrará una página con una ventanilla despegable en la parte superior diciendo 
«Confirmation Receipt - Your File Was Received» (Recibo de Confirmación - Su 
Registro ha sido Recibido). 

 Seleccione el botón que dice «Save and Quit» (Guardar y Salir) para salir sin 
presentar la corrección de su registro de salario al Seguro Social. Cuando seleccione 
este botón, aparecerá la página de «Are you sure you want to save and exit W-2 Online 
without submitting your annual wage report to SSA?» para ayudarlo. 

 Seleccione el botón que dice Previous para regresar a la página titulada «Print 
Unsubmitted Form(s) W-2 for Review» (Imprimir el Formulario(s) W-2 que no ha 
sido presentado para ser revisado(s)).  
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PASO 16: Aparecerá una ventanilla despegable para imprimir en la parte superior de la página 
titulada «Confirmation Receipt - Your File Was Received» (Recibo de Confirmación – 
su Informe fue Recibido). En esta ventanilla puede elegir una de las siguientes 
opciones: 

 Seleccione el botón que dice OK para imprimir la página del «Confirmation Receipt – 
Your file was received».  

 Seleccione el botón que dice Cancel para cerrar la ventanilla desplegable.  
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PASO 17: En la página de «Confirmation Receipt – Your File Was Received», usted puede elegir 
una de las siguientes opciones: 

 Seleccione el botón que dice Print this Page para imprimir la página de confirmación.  

 Seleccione el botón que dice Go to Save Oficial PDF para ir a la página de Save PDF 
(Guardar PDF). 

El registro de su salario estará disponible para que lo revise bajo su cuenta de BSO hasta la 
fecha que se muestra en la página de su «Save PDF» (Guardar PDF). 

 

PASO 18: Haga un clic derecho en el nombre del registro (<filename.pdf>) en la página titulada 
«Save PDF» para ver o guardar el informe presentado.  

 Seleccione el botón que dice «Start a New Wage Report» para regresar a la página 
titulada «Before You Create Your Form(s) W-2/ W-3» (Antes que Comience a Llenar 
su(s) Formulario(s) W-2c/W-3). 

 Seleccione el botón que dice «View Unsubmitted Reports» (Ver los Informes que No 
se han Presentado) para ir a la página titulada «Unsubmitted Reports». 

 Seleccione el botón que dice EWR Home para regresar a la página inicial del «EWR ».   
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 LECCIÓN 2: CÓMO DESCARGAR LOS REGISTROS PRESENTADOS 
Siga las siguientes instrucciones para descargar un expediente en formato de «Adobe» que 
contiene los formularios W-2 y W-3 referente a un informe del formulario W-2 remitido 
electrónicamente durante los últimos 30 días.      

Informes de registros de salarios que ya han sido presentados están disponibles por 30 días o 
hasta el 31 de diciembre, lo que ocurra primero.  

PASO 1: Seleccione el enlace que dice Save (or Print) Submitted W-2 Report(s)/PDF to Your 
Computer (Guardar (o Imprimir) Informes de W-2 Presentados en PDF a su 
computadora) que está bajo la ceja de los formularios W-2/ W-3 Online en la página 
inicial del EWR. El sistema mostrará la página titulada «Download Submitted Reports» 
(Descargar Informes Presentados). 
 

 
 

PASO 2:  Haga un clic derecho en el enlace WFID en la página titulada «Download Submitted 
Reports» para ver un menú que incluye las siguientes opciones:   

o Seleccione el botón que dice «Save Target As» (Guardar Registro Como) para 
descargar el expediente a su computadora.  

o Seleccione el botón que dice «Open in New Window» (Abrir en Ventanilla 
Nueva) para ver el registro. 



Guía del BSO - Año Tributable 2011                                                                       W-2 por Internet  
  
 

   
Administración del Seguro Social  Página 17 

Nota: Se requiere el programa de computadora «Adobe Acrobat Reader» para ver el  
 expediente de salarios que descargó. Si no tiene una copia de éste programa de 
 computadora, puede obtener una copia en http://www.adobe.com. 

   Seleccione el botón que dice Quit para regresar a la página inicial del EWR.  

               Seleccione el botón que dice «Start a New Report» para proceder a la página titulada                          
«Before You Create Your Form(s) W-2/W-3» (Antes que Comience a Llenar su(s)  
Formulario(s) W-2c/W-3). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://www.adobe.com./
http://www.adobe.com./
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Apéndice: Otras Páginas 

1. ¿Está Seguro que Quiere Borrar esta Página del W-2? 

Si un usuario selecciona el botón que dice «Delete This W-2» (Borrar este W-2) en la página 
titulada «Enter W-2 Information» (Ingresar la Información del W-2), el sistema mostrará la 
página con la pregunta «Are you sure you want to delete this W-2?» (¿Está seguro que quiere 
borrar este W-2?).    

 

2. ¿Está Seguro que Quiere Guardar y Salir de la Página Electrónica del W-2 
Sin Presentar su Registro Anual de Salario al Seguro Social?  

Si un usuario selecciona el botón que dice «Save and Quit» en la página titulada «W-2 List for 
this Submission (ABC Limited)», en la página «W-3 Preview for this Submission» o en la página 
«Print Unsubmitted Form(s) W-2/W-3 for Review» o en la página «Sign and Submit», el sistema 
mostrará la página con la pregunta «Are you sure you want to save and exit W-2 Online without 
submitting your annual wage report to SSA?». 
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3. ¿Está Seguro que Quiere Borrar la Página que dice Unsubmitted Report? 
(Informe que No ha sido Presentado)  

 
Si un usuario selecciona el botón que dice «Delete» en la página titulada «Unsubmitted 
Reports», el sistema mostará la página con la pregunta «Are you sure you want to delete the 
unsubmitted report?».  

 

4. Página de Restricciones del W-2 por Internet  

Usuarios pueden tener acceso a la página de «W-2 Online Restrictions» seleccionando el botón 
que dice «Continue» en la página titulada «Before Your Create Your Form(s) W-2/W-3» cuando 
el encasillado que dice «Yes, one or more of these situations apply to this wage report» (Si, una o 
más de estas situaciones aplican a este registro de salario) es seleccionado.  
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